Chapter 270

Tests for One-Sample Sensitivity and Specificity

Introduction

The power analysis of a diagnostic test is often based on the sensitivity and specificity of the test. In such a test, the outcome of the diagnostic screening test is compared to the gold standard. In the common case-control study, the gold standard must be known before. In a prospective study, the gold standard is determined subsequent to the study, so the case-control framework is not appropriate. In this procedure, the power analysis and sample size requirements of such a design are considered.

In a prospective study, a group of \( n \) subjects is obtained. Some of the subjects have the disease (condition of interest) and some do not. Each subject is given the diagnostic test for the disease. Subsequently, a gold standard test is used to obtain the true presence or absence of the disease. The gold standard may be a more expensive test, or it may be following the subject to determine if the disease status becomes more apparent.

The measures of diagnostic accuracy are sensitivity and specificity. Sensitivity (Se) is the probability that the diagnostic test is positive for the disease, given that the subject actually has the disease. Specificity (Sp) is the probability that the diagnostic test is negative, given that the subject does not have the disease. Mathematically,

\[
\text{Sensitivity} = \Pr(+\text{test}|\text{disease})
\]

\[
\text{Specificity} = \Pr(-\text{test}|\text{no disease})
\]

Li and Fine (2004) present sample size methodology for testing sensitivity and specificity using a prospective design. Their methodology will be used here. Other useful references are Obuchowski and Zhou (2002), Machin, Campbell, Tan, and Tan (2009), and Zhou, Obuchowski, and McClish (2002).

Prospective Study Design

In a prospective study, a group of \( n \) subjects is split into two groups: those with the disease of interest and those without it. Suppose a particular sample has \( n_1 \) with the disease and \( n_2 \) without the disease. A diagnostic test is administered to each subject (usually before the disease status is determined) and its output is recorded. The diagnostic test outcome is either positive or negative for the disease. Suppose that in the \( n_1 \) subjects with the disease, \( s_1 \) have a positive test outcome and \( s_2 \) have a negative outcome. Similarly, in the \( n_2 \) subjects without the disease \( r_1 \) have positive outcomes and \( r_2 \) have negative outcomes. Sensitivity is estimated by \( s_1 / n_1 \) and specificity is estimated by \( r_2 / n_2 \). A useful diagnostic test has high values of both Se and Sp.
Conditional on the values of \( n_1 \) and \( n_2 \), \( s_i \) is \( \text{Binomial}(n_i, Se) \). Thus, a one-sided test of the statistical hypothesis \( H_0 : Se = Se_0 \) versus \( H_1 : Se = Se_1 > Se_0 \) can be carried out using a binomial test. Hence, the power analysis is based on the binomial distribution conditional on the value of \( n_1 \). Similarly, the hypothesis test \( H_0 : Sp = Sp_0 \) versus \( H_1 : Sp = Sp_1 > Sp_0 \) is also based on the binomial distribution.

### Binomial Model

A binomial variable should exhibit the following four properties:

1. The variable is binary --- it can take on one of two possible values.
2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial. The number of replications is \( n \). The number of times that the outcome of interest is observed is \( r \). Thus \( r \) takes on the possible values \( 0, 1, 2, ..., n \).
3. The probability, \( P \), that the outcome of interest occurs is constant for each trial.
4. The trials are independent. The outcome of one trial does not influence the outcome of the any other trial.

The binomial probability is calculated using the formula

\[
b(x | n, \pi) = \binom{n}{x} \pi^x (1 - \pi)^{n-x} \text{ where } \binom{n}{r} = \frac{n!}{r!(n-r)!}.
\]

Using the binomial probability formula, the sample size necessary to meet both a significance level and a power requirement may be found by solving the following to equations simultaneously:

- Significance Level \( B(s_i > s_a | n_1, Se_0) = \alpha \)
- \( B(s_i > s_a | n_1, Se_1) = 1 - \beta \)

where

\[
B(s_i > s_a | n_1, \pi) = \sum_{x=s_a+1}^{n} b(x | n_1, Se_0)
\]

A similar calculation can be made for the specificity. Further details of this procedure are given in the Tests for One Proportion chapter.

Note that these formulas give \( n_1 \), not \( n \). To obtain \( n \), \( n_1 \) is inflated by the disease prevalence \( P \) to obtain \( n = n_1 / P \). This is called Method 0 in the paper by Li and Fine (2004).

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab

The Design tab contains the parameters associated with this test such as the sensitivities, specificities, sample sizes, alphas, and powers.
Solve For

This option specifies the parameter to be solved for using the other parameters. The parameters that may be selected are $Se_1$, $Sp_1$, Power, and Sample Size. Under most situations, you will select either Power or Sample Size.

Since this procedure actually results in two tests, you can search for Sample Size based on the power of the sensitivity test or the power of the specificity test.

If you want to search for $Se_1$ or $Sp_1$, you must indicate whether to search above or below the values of $Se_0$ or $Sp_0$, respectively.

Test

H1 (Alternative Hypothesis)

Specify the alternative hypothesis of both the sensitivity and the specificity tests. Since the null hypothesis is equality (a difference of zero), the alternative is all that needs to be specified here.

Usually, the two-sided ("≠") option is selected.

Note that the "<" and ">" options are one-sided tests. When you choose one of these, you must make sure that the other settings (i.e. Solve For and Effect Size) are consistent with this choice.

Power and Alpha

Power

This option specifies one or more values for the desired power. Power is the probability of rejecting a false null hypothesis, and is equal to 1 - Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal sensitivities when in fact they are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha and this is still the most common choice today.

Note that because of the discrete nature of the binomial distribution, the alpha level rarely will be achieved exactly.

A single value may be entered here or a range of values such as 0.05 to 0.2 by 0.05 may be entered.

Sample Size

Sample Size

This option specifies the total number of observations in the sample. Values must be integers greater than one.

You may enter a single value or a range of values such as 10, 50, 100 or 10 to 100 by 10.
P (Prevalence)
Specify one or more values for the disease prevalence: the anticipated proportion of the population of interest that has the disease. Because this is a proportion all values must be between zero and one.
You may enter a single value or a range of values such as 0.1, 0.2, 0.3.

Effect Size

Se0 (Null Sensitivity)
This is the value of the sensitivity under the null (H0) hypothesis. The sensitivity estimated from the data is compared to this value by the statistical test. Usually, this is the base line or standard value.
Sensitivity = Pr(+Test|Disease).

Range
All sensitivities must be between zero and one.
You may enter a list of values such as 0.5, 0.6, 0.7 or 0.5 to 0.8 by 0.1.

Se1 (Alternative Sensitivity)
This is the value of the sensitivity under the alternative (H1) hypothesis.
Sensitivity = Pr(+Test|Disease).

Detectable Difference
Se1 – Se0 is the size of the difference that the study will detect.

Range
All sensitivities must be between zero and one. Also, this value cannot be set equal to Se0.
You may enter a list of values such as 0.5, 0.6, 0.7 or 0.5 to 0.8 by 0.1.

Sp0 (Null Specificity)
This is the value of the specificity under the null (H0) hypothesis. The specificity estimated from the data is compared to this value by the statistical test. Usually, this is the base line or standard value.
Specificity = Pr(-Test|Not Disease).

Range
All specificities must be between zero and one.
You may enter a list of values such as 0.5, 0.6, 0.7 or 0.5 to 0.8 by 0.1.

Sp1 (Alternative Specificity)
This is the value of the specificity under the alternative (H1) hypothesis.
Specificity = Pr(+Test|Disease).

Detectable Difference
Sp1 – Sp0 is the size of the difference that the study will detect.

Range
All specificities must be between zero and one. Also, this value cannot be set equal to Se0.
You may enter a list of values such as 0.5, 0.6, 0.7 or 0.5 to 0.8 by 0.1.
Example 1 – Finding the Power

Suppose that diagnosing a certain type of cancer has required expensive and invasive test procedure. The sensitivity of this procedure is 71% and the specificity is 82%. A new diagnostic test has been developed that is much less expensive and invasive. The developers of the test want to design a prospective study to compare the old and new tests using a two-sided binomial test with a significance level of 0.05. They want to consider changes in sensitivity of 10%, 15%, 20%, and 25%. These changes translate to sensitivities of 79.20%, 81.65%, 85.20%, and 88.75%. The prevalence of the disease in the population of interest is 6%. They want to consider a 10% increase in specificity which is 90.2%.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One-Sample Sensitivity and Specificity procedure window by expanding Proportions, clicking on Sensitivity and Specificity, and then clicking on Tests for One-Sample Sensitivity and Specificity. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

### Option

#### Design Tab

- **Solve For**: Power
- **H1 (Alternative Hypothesis)**: H1: Se ≠ Se0, H1: Sp ≠ Sp0
- **Alpha**: 0.05
- **n (Sample Size)**: 300 to 3000 by 300
- **P (Prevalence)**: 0.06
- **Se0 (Null Sensitivity)**: 0.71
- **Se1 (Alternative Sensitivity)**: 0.7920 0.8165 0.8520 0.8875
- **Sp0 (Null Specificity)**: 0.82
- **Sp1 (Alternative Specificity)**: 0.902

#### Plots Tab

- **Probabilities Decimals**: 4

### Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0874</td>
<td>0.9719</td>
<td>18 300</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
<td>0.0340</td>
<td>0.0360</td>
<td>0.0600</td>
<td></td>
</tr>
<tr>
<td>0.1051</td>
<td>0.9999</td>
<td>36 600</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
<td>0.0256</td>
<td>0.0425</td>
<td>0.0600</td>
<td></td>
</tr>
<tr>
<td>0.1813</td>
<td>1.0000</td>
<td>54 900</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
<td>0.0349</td>
<td>0.0488</td>
<td>0.0600</td>
<td></td>
</tr>
<tr>
<td>0.3429</td>
<td>1.0000</td>
<td>72 1200</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
<td>0.0385</td>
<td>0.0439</td>
<td>0.0600</td>
<td></td>
</tr>
<tr>
<td>0.3846</td>
<td>1.0000</td>
<td>90 1500</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
<td>0.0362</td>
<td>0.0481</td>
<td>0.0600</td>
<td></td>
</tr>
<tr>
<td>0.4183</td>
<td>1.0000</td>
<td>108 1800</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
<td>0.0333</td>
<td>0.0462</td>
<td>0.0600</td>
<td></td>
</tr>
</tbody>
</table>

270-5

© NCSS, LLC. All Rights Reserved.
Tests for One-Sample Sensitivity and Specificity

References

Report Definitions
Sens. Power is the power of the sensitivity test. It is based on the N1 observations.
Spec. Power is the power of the specificity test. It is based on the N-N1 observations.
N is the total sample size of the study. It is equal to N1 + N2.
Se0 is the sensitivity under H0. The sensitivity is the proportion of diseased subjects that yield a positive test result.
Se1 is the sensitivity under H1. The sensitivity is the proportion of diseased subjects that yield a positive test result.
Sp0 is the specificity under H0. The specificity is the proportion of non-diseased subjects that yield a negative test result.
Sp1 is the specificity under H1. The specificity is the proportion of non-diseased subjects that yield a negative test result.
Target Alpha is the alpha (probability of rejecting H0 when H0 is true) that was desired.
Actual Sens. Alpha is the alpha that was actually achieved by the sensitivity test, calculated from the binomial distribution.
Actual Spec. Alpha is the alpha that was actually achieved by the specificity test, calculated from the binomial distribution.
P is proportion of the population that actually has the condition (disease) of interest, called the prevalence.

Summary Statements
A total sample size of 300 (which includes 18 subjects with the disease) achieves 9% power to detect a change in sensitivity from 0.71 to 0.792 using a two-sided binomial test and 97% power to detect a change in specificity from 0.82 to 0.902 using a two-sided binomial test. The target significance level is 0.05. The actual significance level achieved by the sensitivity test is 0.0340 and achieved by the specificity test is 0.0360. The prevalence of the disease is 0.06.

This report shows the values of each of the parameters, one scenario per row. Because of the discrete nature of the binomial distribution, the stated (Target) alpha is usually greater than the actual alpha. Hence, we also show the Actual Alpha along with the rejection region.

Sens. Power
This is the power of the sensitivity test. It is calculated from the binomial distribution using the N1 observations of the diseased subjects.

Spec. Power
This is the power of the specificity test. It is calculated from the binomial distribution using the N-N1 observations of the non-diseased subjects.

N
This is the total sample size of the study, n. It is equal to N1 + N2. The number of diseased subjects is N1 = NP. The number of non-diseased subjects is N2 = N(1-P).

Se0
This is the sensitivity under H0. The sensitivity is the proportion of diseased subjects that yield a positive test result.

Se1
This is the sensitivity under H1. The difference between Se1 and Se0 is the difference that is detected by the study.
**Sp0**

is the specificity under H0. The specificity is the proportion of non-diseased subjects that yield a negative test result.

**Sp1**

This is the specificity under H1. The difference between Sp1 and Sp0 is the difference that is detected by the study.

**Target Alpha**

This is the alpha (probability of rejecting H0 when H0 is true) that was desired. Because the binomial is a discrete distribution, the target value is seldom obtained. Rather, the actual value is lower than alpha.

**Actual Sens. Alpha**

This is the alpha that was actually achieved by the sensitivity test, calculated from the binomial distribution.

**Actual Spec. Alpha**

This is the alpha that was actually achieved by the specificity test, calculated from the binomial distribution.

**P**

This is proportion of the population that actually has the condition (disease) of interest, called the prevalence.

---

**Plots Section**

![Sensitivity Power vs n by Se1 plot](image)

Se0=0.7100 Sp0=0.8200 Sp1=0.9020 P=0.0600 a=0.0500 2-Sided

- **Se1**
  - 0.7920
  - 0.8165
  - 0.8520
  - 0.8875

---

[Image Link to Tests for One-Sample Sensitivity and Specificity]
These plots show the relationship between power, sample size, and Se1 in this example.
Example 2 – Finding the Sample Size

Continuing with Example 1, suppose you want to study the impact of various choices for Se1 on sample size. Using a significance level of 0.05 and 90% power, find the sample size when Se1 is 79.20%, 81.65%, 85.20%, and 88.75%. Assume that a two-tailed binomial test will be used.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One-Sample Sensitivity and Specificity procedure window by expanding Proportions, clicking on Sensitivity and Specificity, and then clicking on Tests for One-Sample Sensitivity and Specificity. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option 
Design Tab
Solve For ................................................ Sample Size (Sensitivity)
H1 (Alternative Hypothesis) .................... H1: Se ≠ Se0, H1: Sp ≠ Sp0
Power ...................................................... 0.90
Alpha ..................................................... 0.05
P (Prevalence) ........................................ 0.06
Se0 (Null Sensitivity)............................ 0.71
Se1 (Alternative Sensitivity) .................... 0.792 0.864 0.828 0.8875
Sp0 (Null Specificity)............................ 0.82
Sp1 (Alternative Specificity) .................... 0.902

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Sample Size</th>
<th>Sensitivity</th>
<th>Specificity</th>
<th>Se0</th>
<th>Se1</th>
<th>Sp0</th>
<th>Sp1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9060</td>
<td>1.0000</td>
<td>299,4983</td>
<td>0.7100</td>
<td>0.7920</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9054</td>
<td>1.0000</td>
<td>173,2883</td>
<td>0.7100</td>
<td>0.8165</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9128</td>
<td>1.0000</td>
<td>93,1550</td>
<td>0.7100</td>
<td>0.8520</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9153</td>
<td>1.0000</td>
<td>55,917</td>
<td>0.7100</td>
<td>0.8875</td>
<td>0.8200</td>
<td>0.9020</td>
<td>0.0500</td>
</tr>
</tbody>
</table>

This report shows the sample size needed to achieve 90% power for each value of Se1.
Example 3 – Validation using Li and Fine

Li and Fine (2004) page 2545 give the results of a power analysis indicate that if Se0 = 0.5, Se1 = 0.9, P = 0.01, alpha = 0.05 (one-sided), and power = 0.90, that \( n = 1100 \).

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One-Sample Sensitivity and Specificity procedure window by expanding Proportions, clicking on Sensitivity and Specificity, and then clicking on Tests for One-Sample Sensitivity and Specificity. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Sample Size (Sensitivity)</td>
</tr>
<tr>
<td>H1 (Alternative Hypothesis)</td>
<td>H1: Se &gt; Se0, H1: Sp &gt; Sp0</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>P (Prevalence)</td>
<td>0.01</td>
</tr>
<tr>
<td>Se0 (Null Sensitivity)</td>
<td>0.5</td>
</tr>
<tr>
<td>Se1 (Alternative Sensitivity)</td>
<td>0.9</td>
</tr>
<tr>
<td>Sp0 (Null Specificity)</td>
<td>0.5</td>
</tr>
<tr>
<td>Sp1 (Alternative Specificity)</td>
<td>0.9</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>--- Power --- Sample Size --- Sensitivity --- Specificity ---</td>
<td>0.9104</td>
<td>1.0000</td>
<td>11 1100</td>
<td>0.5000</td>
<td>0.9000</td>
<td>0.5000</td>
<td>0.9000</td>
<td>0.0500</td>
<td>0.0327</td>
<td>0.0448</td>
<td>0.0100</td>
<td></td>
</tr>
</tbody>
</table>

PASS has also obtained an \( n \) of 1100.

It is interesting to note that a sample size of 1050 will also result in the identical power. This is because the amount of interest is \( N1 \) which is 11. If \( n \) is 1050, \( N1 = nP = 1050 \times 0.01 = 10.5 \sim 11 \). Thus all values of \( n \) between 1050 and 1149 will result in the same power.

Also, the value of the power in the article is 0.904 while PASS has obtained 0.910. This difference arises because 0.904 is the unconditional power while 0.910 is the conditional power.